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1 Введение

Пакет hyperref имеет большое количество опций. Опции перечисляются через запятую в
необязательном аргументе команды \usepackage при подключении пакета

\usepackage[список опций]{hyperref}

либо после подключения пакета в аргументе команды

\hypersetup{список опций}

\hypersetup используется не только в преамбуле, но и в окружении document для того,
чтобы менять различные PDF настройки прямо по ходу документа. Каждая опция в списке
задаётся в формате

опция=значение

Для опций булевого типа значение true можно опускать.

2 Стартовая страница документа

Опция

pdfstartpage=целое число

задаёт номер страницы, с которой начинается показ документа. По умолчанию значение
опции равно 1.

3 Вид страницы в окне Acrobat Reader

В этом разделе описаны опции pdfstartview, pdfpagescrop и pdfpagelayout. Они
определяют, в каком виде страницы PDF документа отображаются в окне Acrobat Reader.

3.1 Масштаб и позиция

Опция

pdfstartview={вид страницы}

задаёт размещение страницы PDF документа в окне Acrobat Reader при её загрузки. вид
страницы может принимать следующие значения:

XYZ left top zoom Размер страницы изменяется в zoom раз, после чего страница продёр-
гивается так, чтобы её координаты left и top находились в левом верхнем углу окна1.
Если страница после изменения размера целиком помещается в окне, то, естественно,
никакого продёргивания не делается. Значение null для любого параметра left, top
или zoom поддерживает неизменным текущее значение этого параметра. Для zoom
значение 0 эквивалентно null.

1Значения координат задаются в больших пунктах (72 bp равны 1 дюйму). Для страницы формата A4 левый
нижний угол имеет координаты (0,0), а правый верхний — (595,842).
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Fit Страница целиком подгоняется под размер окна и центрируется; соответствует „Fit
in Window” в Acrobat Reader.

FitH top Страница подгоняется по ширине окна и продёргивается по вертикали так, чтобы
её координата top совпадала с верхним краем окна. Если страница после подгонки по
ширине окна целиком помещается в нём, то, естественно, никакого продёргивания не
делается. Если top не указать, то продёргивания не будет в любом случае.

FitV left Страница подгоняется по высоте окна и продёргивается по горизонтали так,
чтобы её координата left совпадала с левым краем окна. Если страница после подгонки
по высоте окна целиком помещается в нём, то, естественно, никакого продёргивания
не делается. Если left не указать, то продёргивания не будет в любом случае.

FitR left bottom right top Прямоугольная область страницы, заданная координатами left,
bottom, right и top, целиком подгоняется под размер окна и центрируется.

FitB Ограничивающий прямоугольник подгоняется под размер окна и центрируется2.

FitBH top Ширина ограничивающего прямоугольника подгоняется по ширине окна и
страница продёргивается по вертикали так, чтобы её координата top совпадала с верх-
ним краем окна. Если страница после изменения размера целиком помещается в окне,
то, естественно, никакого продёргивания не делается. Если top не указать, то продёр-
гивания не будет в любом случае.

FitBV left Высота ограничивающего прямоугольника подгоняется по высоте окна и стра-
ница продёргивается по горизонтали так, чтобы её координата left совпадала с левым
краем окна. Если страница после изменения размера целиком помещается в окне, то,
естественно, никакого продёргивания не делается. Если left не указать, то продёрги-
вания не будет в любом случае.

3.2 Видимая область страницы

Опция

pdfpagescrop={left bottom right top}

позволяет обрезать края страницы при просмотре PDF документа в Acrobat Reader. Здесь
целые числа left, bottom, right и top — это x- и y-координаты в больших пунктах соответст-
венно левого нижнего и правого верхнего углов видимой области страницы.

3.3 Компановка страниц

Компановку страниц в окне Acrobat Reader в момент открытия документа можно задать
через опцию

pdfpagelayout=компоновка страниц

компоновка страниц может принимать следующие значения:

2Ограничивающий прямоугольник — это прямоугольник наименьшего размера, охватывающий всё содер-
жание страницы. Если какая-нибудь его сторона лежит вне видимой области страницы, то используется
соответствующая сторона видимой области (см. раздел Видимая область страницы).
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SinglePage Только одна страница (или её часть) может присутствовать на экране. Дейст-
вует по умолчанию.

OneColumn Страницы компануются друг за другом в одну колонку (то, что задаётся в
Acrobat Reader через пункт меню View ⇒ Continuous).

TwoColumnLeft Страницы компануются в две колонки, причём нечётные страницы рас-
полагаются слева.

TwoColumnRight Страницы компануются в две колонки, причём нечётные страницы
располагаются справа (то, что задаётся в Acrobat Reader через пункт меню View ⇒
Continuous-Facing).

3.4 Вид страницы для гиперссылок

Опция

pdfview={вид страницы}

задаёт вид страницы, на которую происходит переход по гиперссылки. Значение по умол-
чанию — FitBH.

4 Презентации

В этом разделе описаны опции pdfpagetransition и pdfpageduration. Они опреде-
ляют, как страницы PDF документа сменяют друг друга на экране, и используются обычно
при создании электронных презентаций.

В Acrobar Reader в полноэкранной моде просмотра документа можно установить разные
типы появления на экране новых страниц. Тип по умолчанию выбирается из списка „Default
Transition” (File⇒ Preferences⇒ Full Screen в Acrobat Reader 4 или Edit⇒ Preferences, Full
Screen в Acrobat Reader 5). Именно он используется, когда в самом документе не указано,
как должна появлятся страница на экране. Пакет hyperref позволяет через опцию

pdfpagetransition=тип перехода

задать любой тип, причём менять тип перехода можно по ходу документа, задавая его в
аргументе команды \hypersetup. Переходные эффекты хорошо смотрятся, когда стра-
ница документа отображается на экране целиком. Но hyperref не проверяет, установлена
полноэкранная мода просмотра или нет, подогнана страница под размер окна или нет. Об
этом надо позаботится самому. тип перехода состоит из названия перехода и набора необя-
зательных ключей для выбора разных вариантов одного типа. Набор ключей зависит от типа
перехода. Пример:

\hypersetup{pdfpagetransition={Box /D 2 /M /O}}

Ниже описаны все типы переходов, включая их названия и ключи:

Split Две линии, скользя по экрану, открывают новую страницу. Линии могут быть
горизонтальными или вертикальными. Они движутся либо навстречу друг другу с
краёв экрана к центру, либо от центра к краям. Тип линий задаётся ключом /Dm с
допустимыми значениями /H (горизонтальные) и /V (вертикальные). Направление
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движения регулируется ключом /M, который может принимать значение /I (внутрь)
или /O (наружу). По умолчанию действуют ключи: /Dm /H /M /I.

Blinds Несколько эквидистантных линий, скользя синхронно по экрану, открывают но-
вую страницу. Линии могут быть горизонтальными или вертикальными. Их тип зада-
ётся ключом /Dm с допустимыми значениями /H (горизонтальные) и /V (вертикаль-
ные). Горизонтальные линии движутся вниз, а вертикальные — вправо. По умолчанию
действует ключ: /Dm /H.

Box Квадратная рамка, сжимаясь с краёв к центру экрана или разжимаясь из центра
экрана, открывает новую страницу. Направление движения регулируется ключом /M,
который может принимать значение /I (внутрь) или /O (наружу). По умолчанию
действует ключ: /M /I.

Wipe Прямая линия, скользя от одного края экрана к противоположному, открывает новую
страницу. Направление движения регулируется ключом /Di, который может прини-
мать значение 0 (слева направо), 90 (снизу вверх), 180 (справа налево) или 270
(сверху вниз). По умолчанию действует ключ: /Di 0.

Dissolve Старая страница исчезает маленькими кусочкам.

Glitter Старая страница исчезает маленькими кусочкам, но в отличие от Dissolve, не
на всей странице сразу, а в широкой полосе, которая скользит по экрану. Направление
движения регулируется ключом /Di, который может принимать значение 0 (слева
направо), 270 (сверху вниз) или 315 (из левого верхнего угла в правый нижний). По
умолчанию действует ключ: /Di 0.

R Новая страница замещает старую без каких-либо эффектов.

Все типы перехода, кроме R, имеют также опцию /D. Она задаёт длительность перехода в
секундах. По умолчанию значение опции равно 1.

Опция

pdfpageduration=число

позволяет задать автоматический режим смены страниц. В качестве значения опции ука-
зывается время в секундах, в течение которого текущая страница отображается на экране
перед тем, как будет выведена следующая. Пользователь может в любое время сам сменить
страницу.

5 Вид окна Acrobat Reader

5.1 Мода просмотра

Опция

pdfpagemode=мода

задаёт моду просмотра документа. мода может принимать следующие значения:

None Окно с документом занимает всю клиентскую область окна приложения Acrobat
Reader. Действует по умолчанию.
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UseOutlines Наряду с окном, содержащим документ, отображается окно с закладками
и миниатюрными изображениями страниц, причём сверху находится панель с заклад-
ками.

UseThumbs Наряду с окном, содержащим документ, отображается окно с закладками и
миниатюрными изображениями страниц, причём сверху находится панель с миниа-
тюрами.

FullScreen Полноэкранная мода просмотра документа. (В Acrobat Reader можно вклю-
чить/выключить комбинацией клавиш Ctrl+L.)

5.2 Интерфейс пользователя

Опции булевого типа

pdfmenubar, pdftoolbar, pdfwindowui

позволяют скрыть/показать соответственно Главное меню, Панель инструментов и осталь-
ные элементы интерфейса пользователя (строка состояния, линейки прокрутки, окно с за-
кладками и миниатюрными изображениями страниц). По умолчанию значения всех опций
заданы как true.

5.3 Размер и позиция

Следующие опции булевого типа влияют на размер и положение окна Acrobat Reader в
момент загрузки в него PDF документа:

pdfcenterwindow Позиционирует окно с документом в центре экрана; значение по
умолчанию — false.

pdffitwindow Подгоняет размер окна к размеру первой показанной страницы; значение
по умолчанию — false.

Отметим также опцию булевого типа

pdfnewwindow

которая регулирует, открывают гиперссылки новый PDF файл в новом окне или нет; значе-
ние по умолчанию — false.

6 Внешний вид гиперссылок

Оформление текста гиперссылки регулируется двумя опциями булевого типа:

colorlinks, frenchlinks

По умолчанию значения обеих опций равно false3 и текст гиперссылки печатается обыч-
ным шрифтом без выделения цветом, но вокруг него рисуется рамка4. Если colorlinks
присвоить значение true, то текст гиперссылки будет выделяться цветом, а рамки не будет.

3colorlinks имеет значение true для драйверов tex4ht и dviwindo.
4Такое оформление годится пожалуй только для чёрно-белого выходного устройства.

6



Если же frenchlinks присвоить значение true, то текст гиперссылок будет печататься
шрифтом КАПИТЕЛЬ без выделения цветом.

При вычислении координат углов прямоугольника, который становится активной областью
гиперссылки на PDF странице, LATEX добавляет поля, величина которых задаётся опцией

pdflinkmargin=длина

Причём, если я правильно разобрался, используется значение опции на момент завершения
вёрстки страницы. Вместе с величиной указываются, как это принято в LATEXе, и единицы
изменения, например, 10pt. По умолчанию действует значение 1pt. Опцию имеет смысл
использовать для увеличения расстояния между рамкой и текстом ссылки.

6.1 Цвет текста гиперссылок

Следующие опции определяют цвет текста ссылок разного типа:

linkcolor Цвет текста ссылок на мишени внутри документа; по умолчанию имеет зна-
чение red.

pagecolor Цвет текста ссылок, когда мишенью внутри документа является страница;
по умолчанию имеет значение red.

filecolor Цвет текста ссылок, которые открывают локальные PDF файлы; по умолча-
нию имеет значение cyan.

citecolor Цвет библиографических ссылок, которые печатает команда \cite; по умол-
чанию имеет значение green.

urlcolor Цвет текста ссылок на ресурсы с URL; по умолчанию имеет значение
magenta.

Допустимыми значениями перечисленных выше опций могут быть имена цветов из пакета
color или имена, определённые посредством команды \definecolor из того же пакета,
причём команда становится доступной только после подключения самого пакета.

Отметим также опцию

anchorcolor=цвет

которя задаёт цвет текста мишени; по умолчанию black.

6.2 Окантовка гиперссылок

По умолчанию вокруг гиперссылок рисуется прямоугольная рамка. Линия рамки имеет
толщину 1 bp. Опция

pdfborder={стиль рамки}

позволяет изменить вид рамки. стиль рамки в общем случае состоит из трёх целых чисел
и одного массива чисел. Первые два числа — радиусы закругления углов рамки5, а третье
число — толщина линии рамки. Если в качестве толщины линии указать 0, то рамки не

5Acrobat Reader в среде MS Windows всегда рисует прямоугольную рамку.
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будет. Необязательный массив позволяет заменить сплошную линию на штриховую. Первое
число в массиве задаёт длину штриха, а второе — расстояние между штрихами (не должны
превышать 10). Пример: pdfborder={0 0 2 [6 4]}. Если расстояние между штрихами
совпадает с длиной штриха, то вместо [n n] можно указывать [n]. По умолчанию стиль
рамки задан как 0 0 1.

Следующие опции определяют цвет рамки вокруг ссылок разного типа:

linkbordercolor Цвет рамки для гиперссылок на мишени внутри документа; по умол-
чанию имеет значение 1 0 0.

pagebordercolor Цвет рамки для гиперссылок, когда мишенью внутри документа яв-
ляется страница; по умолчанию имеет значение 1 1 0.

filebordercolor Цвет рамки для гиперссылок, которые открывают локальные PDF
файлы; по умолчанию имеет значение 0 .5 .5.

citebordercolor Цвет рамки для библиографических ссылок, которые печатает ко-
манда \cite; по умолчанию имеет значение 0 1 0.

urlbordercolor Цвет рамки для гиперссылок на ресурсы с URL; по умолчанию имеет
значение 0 1 1.

runbordercolor Цвет рамки для гиперссылок по схеме run; по умолчанию имеет
значение 0 .7 .7.

Цвет в перечисленных выше опциях задаётся в цветовой модели RGB как три числа от 0
до 1.

6.3 Цвет гиперссылки на элементы меню

Следующие опции определяют цвет для ссылок на элементы меню, созданные посредством
команды \Acrobatmenu:

menucolor Цвет гиперссылки на элементы меню; задаётся по имени из пакета color или
имени, определённому посредством команды \definecolor из того же пакета; зна-
чение по умолчанию — red.

menubordercolor Цвет рамки вокруг гиперссылки на элементы меню; задаётся в цвето-
вой модели RGB как три числа от 0 до 1; значение по умолчанию — 1 0 0.

6.4 Выделение активных гиперссылок

Опция

pdfhighlight=ключ

устанавливает выделение гиперссылок, когда кнопка мыши нажимается и держится нажа-
той, а указатель мыши находится в активной области. Допустимые значения опции задаются
спецификацией PDF 1.2: ключ /N— не выделяется; /I— инвертируется цвет содержания;
/O— инвертируется цвет границы; /P— имитируется вдавливание (неплохо смотрится на
цветном или сером фоне). По умолчанию действует ключ /I.

Следующие ссылки демонстрируют действие ключа /I, ключа /O , ключа /P .
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6.5 Разрыв текста гиперссылки

Опция булевого типа

breaklinks

разрешает/запрещает разбивать текст гиперссылки для переноса на другую строку. Для
драйвера pdftex значение по умолчанию равно true, в остальных случаях — false.

7 Закладки

Опция булевого типа

bookmarks

определяет, будут или не будут созданы закладки для документа. По умолчанию опция имеет
значение true. Для того, чтобы в закладках были видны русские буквы, пакет hyperref надо
подключать с опцией unicode. Вид закладок в Acrobat Reader регулируется следующими
опциями:

bookmarksnumbered Задаёт нумерацию разделов; по умолчанию — false.

bookmarksopen Раскрывает полностью дерево закладок; по умолчанию — false.

bookmarksopenlevel=целое число Задаёт уровень, до которого раскрывается дерево
закладок; можно менять по ходу документа. По умолчанию раскрывается полностью.

bookmarkstype Устанавливает, какой файл с таблицей содержания воспроизводится в
закладках; по умолчанию — toc.

8 Опции, влияющие на создание гиперссылок

По умолчанию гипертекстовыми ссылками является текст элементов оглавления и списков
таблиц и рисунков. Опция булевого типа

linktocpage

делает гиперссылками номера страниц в этих таблицах, а не текст элементов. Значение по
умолчанию — false.

Опция булевого типа

hyperfootnotes

определяет, будут или не будут подстрочные примечания гипертекстовыми ссылками. Зна-
чение по умолчанию — true.

Опция булевого типа

hyperindex

определяет, будут или не будут номера страниц в предметном указателе гипертекстовыми
ссылками. Значение по умолчанию — true. Если в команде \index используются команды
выбора шрифта для печати номера станицы, которые, как известно, начинаются в этом
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случае с символа |, то такие номера не становятся гиперссылками. Дело в том, что пакет
hyperref сам использует в \indexentry символ | для записи команды \hyperpage.
Проблема решается очень просто. Надо ввести новую команду, например, \Emph в виде

\newcommand{\Emph}[1]{\emph{\hyperpage{#1}}}

и вместо \index{термин|emph} писать \index{термин|Emph}.

Опция булевого типа

pageanchor

определяет, будет или не будет создана мишень в левом верхнем углу на каждой странице.
Значение по умолчанию — true. Если опцию отключить, то номера страниц в предметном
указателе не будут работать как гипертекстовые ссылки, поскольку они используют эти
мишени.

Если по ходу документа командой \pagenumbering меняется формат нумерации страниц
(вручную, скажем, при переходе от оглавления к тексту самого документа или через команды
\frontmatter и \mainmatter в классе book), то необходимо отключить опцию

plainpages

По умолчанию она имеет значения true и в мишенях, которые создаются на каждой
странице, всегда используется значение счётчика page в формате arabic. Поскольку
\pagenumbering начинает счёт страниц заново, такое определение имён мишений при-
водит к попытке создать мишень с уже существующим именем (ведь i, ii и т. д. или a, b и
т. д. превращаются в 1, 2 и т. д.). В результате, вторая мишень под тем же именем не созда-
ётся. Но именно эти мишени используют ссылки в предметном указателе. Если же опции
plainpages присвоит значение false, то в мишенях будут использоваться номера стра-
ниц без преобразования в формат arabic. Описанное справедливо, когда не выключена
опция булевого типа

hypertexnames

По умолчанию она имеет значение true. Если эту опцию отключить, то hyperref вместо
счётчиков LATEXа будет использовать свои счётчики, причём значение счётчика страниц не
совпадает в обсуждаемой ситуации с номерами страниц и ссылки в предметном указателе
будут работать неверно.

Пакет hyperref позволяет создать обратные гиперссылки из библиографического списка:
в конец каждого элемента списка добавляются в виде гиперссылок номера страниц или
номера разделов, где встречаются прямые ссылки на этот элемент. Обратные гиперссылки
в виде номера страницы создаются, если задана опция

pagebackref

По умолчанию её значение равно false. При наличии опции

backref

(по умолчанию её значение равно false) создаются гиперссылки в виде номера разделов,
причём только в том случае, когда после каждого элемента библиографического списка
оставлена пустая строка или стоит команда \par.

Опцией булевого типа

draft

можно отключить все гипертекстовые опции. Значение по умолчанию — false.
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9 Базовый URL

Опция

baseurl=URL

позволяет такие параметры ресурса как протокол, адрес машины в сети и часть пути указать
как базовый адрес URL и после этого в командах \href и \hyperref использовать
неполный (относительный) указатель ресурса.

Если базовый URL не задан (через опцию baseurl или в команде \hyperbaseurl), то
неполный URL в гиперссылках отсчитывается относительно расположения самого доку-
мента.

10 Информация о документе

Опции

pdftitle, pdfsubject, pdfauthor, pdfkeywords

позволяют задать соответственно название документа, тему, автора(ов) и список ключевых
слов, которые будут отображены в окне с информацией о PDF документе (File⇒ Document
Info ⇒ General в Acrobat Reader 4 или File ⇒ Document Properties ⇒ Summary в Acrobat
Reader 5). Если вы задаёте текст на русском языке, то пакет hyperref надо подключать с
опцией unicode, а значения опциям присваивать через \hypersetup после загрузки
пакета.

Вы можете также сами задать текст для опций

pdfcreator, pdfproducer

11 PDF строки

Опция булевого типа

unicode

делает переключение между кодировками PDFDocEncoding и Unicode для текста, кото-
рый пишется в выходной файл без полной обработки LATEX’ом. PDF строки использует-
ся в закладках и в полях с информацией о документе. Значение по умолчанию — false.
PDFDocEncoding не содержит русских букв, поэтому при использовании русского текста в
PDF строках необходимо включить опцию unicode.
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